GLPS Publications Style Sheet

Global Publishing Services

SIL International®
2013

This manual of style serves authors, content and copy editors, and compositors. The textual guidelines and illustrative samples will clarify the norms used to prepare books and articles for publication by Global Publishing Services (GPS)—the academic publishing arm of the Global Language Program Services (GLPS), SIL International (SIL).

Four appendices supplement the textual information: Appendix A gives the SIL Template style names and further illustrates the styles. Appendix B gives the specifications used for each style. Appendix C highlights additional features important for editing. Finally, Appendix D is a checklist useful to verify that all major editing considerations have been reviewed before the manuscript is published by GPS.
# Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Appendix A, section 1</td>
</tr>
<tr>
<td>B2</td>
<td>Appendix B, section 2</td>
</tr>
<tr>
<td>Bk</td>
<td>Book(s)</td>
</tr>
<tr>
<td>Ch</td>
<td>Chapter</td>
</tr>
<tr>
<td>Chr</td>
<td>Character</td>
</tr>
<tr>
<td>CMOS</td>
<td><em>The Chicago Manual of Style, 16th Edition</em></td>
</tr>
<tr>
<td>Ctrd</td>
<td>Centered</td>
</tr>
<tr>
<td>E-Bks</td>
<td>Electronic books</td>
</tr>
<tr>
<td>E-Book</td>
<td>Electronic book</td>
</tr>
<tr>
<td>GLPS</td>
<td>Global Language Program Services</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Publishing Services</td>
</tr>
<tr>
<td>Hdg</td>
<td>Heading</td>
</tr>
<tr>
<td>ISBN</td>
<td>International Standard Book Number</td>
</tr>
<tr>
<td>ISO</td>
<td>Three-letter codes for identifying languages (International Organization for Standardization)</td>
</tr>
<tr>
<td>ISSN</td>
<td>International Standard Serial Number</td>
</tr>
<tr>
<td>L</td>
<td>Left</td>
</tr>
<tr>
<td>LOC</td>
<td>Library of Congress</td>
</tr>
<tr>
<td>Para</td>
<td>Paragraph(s)</td>
</tr>
<tr>
<td>Pt</td>
<td>Point(s)</td>
</tr>
<tr>
<td>Ref</td>
<td>Reference</td>
</tr>
<tr>
<td>SIL</td>
<td>SIL International</td>
</tr>
<tr>
<td>TOC</td>
<td>Table of Contents</td>
</tr>
<tr>
<td>Vernac</td>
<td>Vernacular</td>
</tr>
</tbody>
</table>
Contents

1 General approach 5
   1.1 Communication with the author
   1.2 Content editing
   1.3 Copy editing
   1.4 Compositing
2 Headers and footers 6
3 Front matter 6
4 Text 7
   4.1 Headings and titles
   4.2 Paragraph styles
   4.3 Bulleted lists and example lists
   4.4 Citation and parenthetic information
   4.5 Footnotes
5 Punctuation 9
   5.1 Quotation marks
   5.2 Commas
   5.3 Ellipses and spacing
   5.4 Hyphens, em dash, and en dash
6 Numbers, numerals, spelling, and dates 11
7 Italic, bolding, and underlining 11
8 Capitalization, abbreviation, and acronyms 11
   8.1 Capitalization of titles
   8.2 Other capitalization and abbreviation
   8.3 Acronyms and abbreviation with full and small caps
9 Vernacular, glosses, and interlinear text 12
   9.1 Vernacular, IPA script, and biblical languages
   9.2 Glosses and free translation in interlinear text
10 Tables, maps, and figures 13
   10.1 Tables and maps
   10.2 Figures
11 Appendices 14
12 References 14
   12.1 Name of authors, editors, translators, and compilers
   12.2 Date
   12.3 Titles
   12.4 Place of publication and publisher
   12.5 Unpublished papers, dissertations/theses, manuscripts
   12.6 References from a website
Appendix A: SIL Template Guidelines 21
Appendix B: Layout Specifications 27
Appendix C: Editing Tips and Checks 31
Appendix D: Compositing and Editing Checklist 33
1 General approach

GLPS follows *The Chicago Manual of Style*, 16th Edition (CMOS), for most questions of style and format. Where necessary to accommodate the conventions of different academic disciplines and different varieties of English, flexibility is allowed. For questions of style beyond the scope of this style sheet, please consult *CMOS*. Use of a different style sheet will be granted only by the GPS Director of Content Services.

1.1 Communication with the author

The GPS project editor initiates correspondence with the author. The goal is to develop a cordial relationship, with a rapid exchange of editor questions and suggestions, and author corrections.

An initial letter may request an abstract (in some cases) and metadata. Metadata includes the *subject language* (using ISO code), the *dialect name* (if applicable), the manuscript *content language* (with ISO) if not English, the *script name* (if non-roman), the *country name* (any country involved), and up to eight *key words*.

In a second letter the editor may propose breaking the manuscript into logical units (for long manuscripts), and negotiate how to comment and make corrections: The editor might correct simple punctuation and grammar errors without comment but works with the author on all content issues. The editor can suggest alternate wording for unclear content, or leave that to the author. Throughout the process the editor assures the author that GPS wants to serve both the author and reader by producing a polished, professional publication.

Along with a list of comments, the editor sends a current PDF to the author for reference but, to avoid multiple edited documents, retains the Word document—so that changes are implemented by the editor.

1.2 Content editing

The following are suggested steps to follow in the editing process: First, if the manuscript already has a table of contents, use it to get an overview. Second, skim the manuscript for a general understanding of the content. Third, read the work carefully and address the following factors:

- **Cohesion**: All parts lead to the intended conclusion, and at each level, all parts are parallel.
- **Clarity**: Where unclear, in a marginal comment, the editor suggests an alternative wording or simply notifies the author of what portion is unclear.
- **Conciseness**: Sentences are complete but not too long or too choppy. Needless repetition can be reworded or eliminated. Detail that is not central can be footnoted or deleted. The editor makes suggestions but the author decides on final wording.
- **Consistency**: Section topics follow the order forecasted in the introduction. Numbering, citation, references, and all internal information and conventions are consistent.
- **Culturally appropriate**: Choice of vocabulary is inoffensive. Mention of religious affiliation and persuasion is as minimal as possible.

1.3 Copy editing

The goal of copy editing is to improve the grammar, spelling and punctuation—and conform the manuscript to GLPS standards for the front matter, text, and end matter. This style sheet and appendices are organized according to the progression in which a copy editor addresses them in the sequential process of editing a manuscript. By following the Appendix D checklist an editor can verify that the most important points were covered in the editing process.
1.4 Compositing

The author applies the SIL template to the manuscript, converting all styles to the SIL template norms. If editors have compositing experience, they will check and correct formatting issues. They, and the final GPS compositors, follow the SIL template electronic styles guidelines and definitions illustrated in Appendices A and B. There the template styles are referred to by their style name in italics, e.g., *SIL Para 1*—the style name for the first of two body text paragraph styles.

One of the final steps for compositors is to generate a table of contents from the final version.

2 Headers and footers

The area at the top of a page is the header and the area at the bottom of a page is the footer. This section briefly explains the use of headers and footers that occupy those areas. See Appendix B (B2, page 27) to see how styles are used to format these upper and lower zones. Papers and books have different norms.

Headers, also called *running heads*, appear above the text, and (running) footers appear below the text. In print books they include the book title and page numbers, and in some books they include chapter names. Pagination appears as footers for the first page of each new part and chapter but as headers in all other contexts. In papers pagination appears at top right for all pages, and no header title is given. GPS compositors will style the header and footer when in final form.

- Pagination guidelines for different types of books are found at B2, page 27.
- The front matter in books is paginated with lower case roman numerals (i, ii, iii, etc.). The page count starts on the title page, a right hand *recto* page. The reverse of this page is called verso. The title and verso pages do not show headers or footers.
- The central text paginates with arabic numerals and starts counting with “1” after the front matter for books, and with the title page for papers. Papers often paginate using only arabic numerals.
- For books, the first marked page of central text will be a recto, odd numbered page. This page number occurs as a footer. Each new major part of the book, including the first page of all chapters, begins on a recto page, as a footer. All other pagination is given as headers. For papers, the first page showing numbering is page 2 or 3, and all pagination appears flush right, as a header.
- Throughout the work blank pages are counted but do not receive a printed number or header.
- Page numbers do not appear at the back of monographs where other SIL publications are listed.

3 Front matter

A work can be divided into three divisions: front matter, text, and end matter. Front matter is discussed here in section 3, a discussion of text begins in section 4, and end matter is discussed in sections 11 and 12.

Much of the front matter is generated by the compositor and so will not be described here in detail. This division of a manuscript includes the title page and, optionally, other parts like the abstract, abbreviations, and contents. Book length works will have a verso page, and may include a foreword, preface and acknowledgements. For more about front matter see pages 21–22 and B3, page 28.

- The **title page** includes title and subtitle, author, publisher, year, and copyright information.
- The **title** and **subtitle** are headline capitalized, i.e., the first word and all subsequent words except prepositions, articles and conjunctions are capitalized. All capital letters are not used in titles or subtitles. For style names, see Appendix A, page 21.
- The **table of contents**, simply entitled *Contents*, is part of the front matter. Generally only two or three levels are given in the contents. It is numbered for books but not included in many of the electronic paper series. It may be followed by an abbreviations list, acknowledgements, a foreword, and/or a preface before the central text begins. It is generated by the GPS compositor.
4 Text

The central text of the manuscript consists of different heading, paragraph, and list types, each with format applied by selecting styles in the SIL template styles panel. See examples in Appendix A, pages 21–26.

4.1 Headings and titles

Headings (as opposed to headers—see section 2) mark major parts or sections within the text. Parts include the abstract, abbreviations, acknowledgments, and contents; other major section breaks include chapter titles and level headings. Part titles are not numbered; chapter titles and level headings are. Headings and titles do not use all capital letters. Vernacular words are italicized in non-italic headings and are in non-italic type in third and fourth level italicized headings.

4.1.1 Part headings, chapter titles, and level one headings

Headings and titles are formatted differently for print books and electronic books and papers, and are described here separately. See examples on page 21, and A1 and A2, page 23.

Print books

- **Part headings** in print books are centered and headline capitalized, i.e., the first word and all subsequent words except prepositions, articles, and conjunctions are capitalized.
- **Chapter titles** for print books are also centered and headline capitalized; the chapter number is entered manually and is given immediately above the title using a no-break space. See example at A1, page 23.
- **Level one headings** for print books are also centered, but they are sentence capitalized, with only the first letter of the first word of the title capitalized.
- If the headings of print books are numbered, they are numbered manually. The sequence restarts with each chapter and includes the chapter numeral, e.g., heading 1 of chapter 1 is 1.1; heading 1 of chapter 2 is 2.1. No punctuation follows either the number or heading text. A tab separates the number from the text. For examples, see 4.1 and 4.1.1, above.
- Collections, which have a different author for each chapter, give the author’s name, then the abstract for the chapter beneath the title.

E-Books and papers

- Part headings and chapter titles are headline capitalized; Level headings are sentence capitalized.
- Part headings, chapter titles, and level headings are all flush left.
- E-Book headings may be numbered like print books. Alternatively, they may be numbered like papers, which don’t include a chapter number either to the left of, or above, the heading.
- Headings and chapter titles are not followed by closing punctuation.

4.1.2 Second, third, and fourth level headings

- Level two headings and all lower level headings are sentence capitalized and positioned flush left. See A2, page 23. As with first level headings the subheading number is followed by a tab and then the heading title, with no period following either the number or the heading text.
- Headings lower than the fourth level are rarely used.
4.2 **Paragraph styles**

All normal text is in 10 pt, Charis SIL font. There are two main paragraph styles and the block quotation style used by GLPS, as illustrated here. See also A3, p. 23. The first paragraph of text occurs as the first paragraph following titles, headings and subheadings. It is not indented, as shown in this paragraph.

All subsequent paragraphs are first-line indented, as shown in this paragraph. No line space occurs between paragraphs.

A block quotation contains four or more lines of quoted text. It is set off from the rest of the text. For information about formatting block quotations, see A3, p. 23. Second and succeeding block quote paragraphs appear as illustrated below. The citation information within parentheses in a block quotation comes after the sentence final punctuation, as shown in this example, taken from *CMOS*:

> Block quotations, which are not enclosed in quotation marks...are further distinguished from the surrounding text by being indented...or set in smaller type [than] the text...

> Length is usually the deciding factor.... Other criteria apply, however. A quotation of two or more paragraphs is best set off, as are quoted correspondence, lists, and any material that requires special formatting. If many quotations of varying length occur close together...it may be better to set them all as block quotations, however short. (2010:623)

4.3 **Bulleted lists, example lists, and item lists**

- **Bulleted lists** are for unordered items. See examples at A5, page 24.
- **Numbered lists** are of two types. See A5, page 24.

1. **List examples** are typically used for language examples and are normally flush left. The numbering occurs within parentheses, as shown by this example number. These are numbered sequentially throughout the work. In the text, example numbers are referred to as (2), (2a), (2a, b), (2a–c), etc.

4.4 **Citation and parenthetic information**

- **Citations** are given within parentheses and include the author’s last name, year of publication and page number(s), with a colon separating year and page number(s). No space occurs following the colon, as in (Fillmore 1968:248, 251). If you refer to an author in the text, only the date and page are enclosed in parentheses, as in “Looney (1987:34) claimed that flamingos are the greatest bird ever.”

- The abbreviation *et al.* may be used in the text for the citation of multiple authors, e.g., (Wonderly et al. 1996), but *et al.* is not used in the references entries. See also 12.1.1, page 14.

- When short length quotations occur within surrounding text, the citation follows the close quotation mark, but is followed by the sentence closing punctuation, e.g., “...this is the end of a short quotation” (Fillmore 1968:248).

- **Parenthetic information** added by the author or editor is identified by enclosing a phrase in square brackets within the quotation or in the parenthesis of the citation. For example, (Longacre 2013:23 [emphasis added]).

4.5 **Footnotes**

Footnotes appear at the bottom of the text area of the page. They are preferred over endnotes. The text of long footnotes may be carried over to the bottom of the following page. If so, the footnote continues in the middle of a sentence so the reader knows that the footnote has not ended.

- To insert a footnote use the toolbar (ribbon): References tab; Insert Footnote. In the text, footnote reference numbers are superscript and placed after punctuation and non-alpha characters.
- Footnotes do not appear in part headings. A note that refers to the book or article as a whole is unnumbered and marked with a symbol rather than number, e.g., an asterisk, and precede the numbered notes. The asterisk is also used to mark a single footnote in an article.
- Footnote numbering starts at the beginning of each chapter with "1."
- Footnotes are removed by deleting the note referent from the text. The actual footnote text is not removed from the bottom of the page.
- The number of footnote lines on each page should be balanced. Avoid very long footnotes and a large number of footnotes, if possible. Also avoid interlinear examples in footnotes when possible.
- Footnotes for tables and figures, i.e., table notes, appear at the bottom of the table or figure. See section 10, page 13 and A6.2, page 25.

5 Punctuation

5.1 Quotation marks

- **Double quotation marks** are used to signal direct speech quotation, e.g., John said, “I am coming,” or a word for word citation from literary sources. Single quotation marks are acceptable if used consistently by an author who prefers British spelling and punctuation.
- Quotation marks, “scare quotes,” as used here, signal non standard use of a term, such as slang, jargon, irony, or for rhetorical effect.
- When a word or term is not used functionally but is referred to as the word or term itself, it is either italicized or enclosed in double quotation marks. Quotation marks may be preferable to italics when there are a significant amount of vernacular examples, which would also appear in italics in the manuscript. When used to highlight a word for effect, the first usage is marked by quotation marks; following occurences of the same word are not marked.
- Double quotation marks are used in the text to set apart titles of articles, plays, papers, chapters, poetry, dissertations; in the references, quotation marks are not used for this purpose.
- Curly quotation marks, “smart quotes,” are preferred over straight quotation marks—which are reserved for technical use, such as the abbreviated measurement symbols for inches (″) and feet (′).
- The closing double quotation mark should normally follow any other adjacent punctuation mark, e.g., “Watch out!” he exclaimed, or “I’ll see you later.”
- **Single quotation marks** enclose a gloss. See also section 9.2, page 13. However, in a table where gloss is listed, quotation marks are unnecessary. The close quotation mark for textual glosses should precede any other adjacent punctuation mark, e.g., achen ‘person, people’.

5.2 Commas

- Commas normally separate items in a series. When a conjunction joins the last two elements in a series, a comma should appear before the conjunction. But, if done consistently and spelling follows British conventions, commas may be omitted preceding the conjunction.
- Different conventions for use of commas may be followed. For example, although a comma normally follows i.e. and e.g., an author may not use a comma. Follow the convention that the author uses, as long as the convention is used consistently in that work.

5.3 Ellipses and spacing

**Ellipses** mark a continuation of a thought that may span textual clauses, sentences, even paragraphs. It is used to link salient information and eliminate what is extraneous.
- Use ellipses sparingly. At the beginning of a quotation an ellipsis is not needed.
• Ellipses generally occur with no space between the ellipsis and the text. However, when the ellipsis represents a span of multiple sentences, a period and space follow the ellipsis mark. If an ellipsis occurs at the end of a line, break after the ellipsis by inserting a space before the following text.

• **Spacing**, using the space bar, never exceeds one consecutive space insertion; even sentence final punctuation (periods and colons) are followed by only one space.

• **Tab** insertion is also used for spacing. Like single space insertion, tabs are inserted to separate example numbers from text, and for language data—to separate columns for interlinear text in the creation of tables.

5.4 **Hyphens, em dash, and en dash**

Symbols for em dash and en dash can be inserted in the text from the ribbon by selecting the Insert tab; Symbol; More Symbols; Special Characters.

5.4.1 **Hyphens**

Hyphenation is kept to a minimum. It normally would not occur on more than two consecutive lines, across a page break, or in the last word of a paragraph.

• Hyphenation marks compound adjectives, e.g., a *book-length* article.

• When a compound hyphenated word occurs at end of a line, if it must be hyphenated, break at the hyphen, e.g., *well-formedness* condition.

• Hyphens are used between numbers that are not inclusive, e.g., ISBNs, Library of Congress numbers, telephone numbers.

• In interlinear text, hyphens signal morpheme-affix breaks. For other linguistic use, follow Crystal.¹

5.4.2 **Em dash**

Em dashes are often used in the text instead of commas, parentheses or colons, e.g., "My friends—David and Jane—came to see me." No spacing occurs between the em dash and adjacent words. At the end of a line, break after the em dash.

• If the work is written in British style, an en dash – with one space on either side, as shown in this sentence – may be used in place of an em dash.

5.4.3 **En dash**

The en dash generally adjoins successive or inclusive numbers. These typically mark a page number sequence, e.g., 71–72, or a date sequence, e.g., August 1–4.

• The en dash is marked with no spacing on either side. However, in British use, when used in place of an em dash, spacing does occur. See an example at 5.4.2, above.

6 **Numbers, numerals, spelling, and dates**

• All *numbers* that can be expressed in one or two words are spelled out, whether exact or approximate. This includes numbers from one through one hundred, and all round numbers above one hundred that require no more than two words, e.g., sixty-two thousand or forty-five million.

• When giving a sequence of numbers include all digits of the second number in the sequence, e.g., 95–96, not 95–6.

• Express percentages as a \textit{numeral} and spell out the word percent. The percent symbol (%) and numerals may be used in tables, on business forms, when parenthetic, in references, and in statistical or technical material. Numerals are also used in an arithmetic expressions, such as, “a frequency of 1 in 18.”

• \textbf{Spelling conventions} for either American English or British English can be used, as long as only that convention is used consistently within the book or article.

• \textbf{Dates} may be given according to either American English or European English style, as long as used consistently within a work e.g., December 28, 2009 (American), or 28 December 2009 (British).

7 \textit{Italics, bolding, and underlining}

Italics, bolding, and underlining are used for emphasis, but are used sparingly.

• Use \textit{italics} for titles of books, journals, collections, and proceedings in the text, but use non-italic type with double quotation marks around the title of an article, chapter, or section in the text. See also section 5.1, page 9.

• Another common use of italic type is for vernacular in the text, which is always italic.

• Italicized or \textbf{bold} text should be followed by punctuation in the same italic or bold typestyle as the text it follows, except with parentheses, braces, quotations, or brackets. However, if the whole text within those markings is italicized, bolded, or small capped, those markings before and after the text will also appear in the same type style.

• \textbf{Underlining}, in general, is used only for emphasis of vernacular text.

8 \textit{Capitalization, abbreviation, and acronyms}

8.1 \textit{Capitalization of titles}

• Standards for capitalization of headings and titles are given in section 4.1.1, page 7.

• In the text, headline capitalize titles of books, journals, articles, and chapters. In headline capitalization, all words are capitalized except prepositions, articles and conjunctions.

• Do not capitalize the terms chapter, section, chart, figure, map, or table in the text when cross referencing.

8.2 \textit{Abbreviations}

• In parenthetical references, terms like chapter, section and figure can be abbreviated, e.g., (see ch. 2, sec. 4, fig. 2.6); reference numbers are given as numerals.

• In the text, names of biblical books are generally spelled out, e.g, Genesis 2:3. In parenthetical references, those names may be abbreviated, typically without a period. e.g., (see Gen 2:3).

• The abbreviation etc is not used frequently, and does not occur following e.g. or for example.

8.3 \textit{Acronyms and abbreviation with full and small caps}

8.3.1 \textit{Full caps}

• Linguistic acronyms: SVO (subject-verb-object), CVC (consonant-vowel-consonant), etc.

• Abbreviations of phrases in formal theories: NP (noun phrase), VP (verb phrase), etc.

• Abbreviations for technical terms, e.g., PF (phonological form) or SS (sentence structure).
• Names of rules, such as equi-NP-deletion (equivalent noun phrase deletion).
• SIL International, and acronyms such as IBM, MIT, etc.
• University degrees, such as Ph.D., M.A., etc.
• Abbreviations of theoretical terms, e.g., ECP (Empty Category Principle).

8.3.2 Full or small caps

• Either full or small caps can be used for language name abbreviations, e.g., QZ or QZ, for Quiegolani Zapotec (Mexico).
• A combination of both full caps (initial letter) and small caps is used, e.g., CONT-INT, SPREAD.

8.3.3 Small caps

• To highlight a technical term in the first instance of its use in the text, e.g., the term MORPHEME, regular type should be used for subsequent occurrences of the term.
• Technical terms, in small caps, are given in diminished sized capital letters, e.g., IN/OUT CONTAINER image schema.
• Abbreviations in glosses, e.g., PL (plural), SG (singular), M (masculine), F (feminine).
• For time reference, e.g., A.D., B.C., A.M. and P.M.—a.m. and p.m. are also acceptable.

9 Vernacular, glosses, and interlinear text

Vernacular is italicized to distinguish it from the text language of communication. However, in tables the vernacular is not italicized. In general, text is not underlined for emphasis, however in vernacular examples a word or morpheme may sometimes be underlined for focus.

9.1 Vernacular, IPA script, and biblical languages

• Vernacular words in the text are italicized, e.g., mari mari’hello’, in Mapudungun (Chile), except when the vernacular occurs within phonetic brackets [maři maři] or phonemic slashes /mari mari/.
• Vernacular words in tables and interlinear text are not italicized.
• Proper nouns in the vernacular are normally capitalized. How complete sentences in the vernacular are capitalized and punctuated is decided by the author but should be consistent throughout a work. If capitalization is not used, sentences in the text may need to be reworded so that lower case vernacular words do not occur as the first word in the sentence.
• International Phonetic Alphabet (IPA) script, e.g., fo’netik, and foreign scripts, e.g., Chinese, are not italicized.
• For biblical language texts, SIL Unicode fonts other than Charis SIL may be preferred. These are Galatia SIL (Greek), Doulos SIL (IPA), and Ezra SIL (Hebrew). For Asia there are other alternatives.

9.2 Glosses and free translation in interlinear text

• A gloss is a translation of vernacular word(s) in a text. Glosses are in lower case, regular type, within single quotes, e.g., in Cubeo (Colombia): xu’nest’.
• A word comprises one or more morphemes (grammatical units). Morphemes within a word are separated by hyphens, e.g., xu-A.

• Grammatical category abbreviations in the gloss are given in small cap upper case, e.g., CAUS (causative). In the body text, these appear in parentheses, e.g., xu-A (nest-CAUS).

• **Free translations** are enclosed in single quotes, e.g., xu-A 'set a trap'.

• **Interlinear text** aligns vernacular words with its gloss and free translation in rows; and the vernacular with its gloss, by columns, separated by tabs. See also A5, page 24.

  | Vernacular | xu-A |
  | Gloss      | nest-CAUS |
  | Free translation | ‘set a trap’ |

• Person reference is glossed as 1, 2, 3, as in 1S (1st person, singular), e.g., in southern Peruvian Quechua: puri-sha-ni (go-CONT-1s) ‘I am going.’

• Periods join two or more words which gloss a single vernacular morpheme, e.g., in Spanish: mostrar ‘to show’. This is not true for the free translation.

• Clitics are syntactic morphemes, phonologically bound. When bound they are separated by an equal sign (=), e.g., what=s (as in what’s) ‘what is’.

• Avoid footnotes in interlinear examples when possible.

10  **Tables, maps, and figures**

• Titles, or headings, for **tables and maps** appear above the information they label, as in table 1.

• A period follows the number but not the text of the heading. If the object is centered, the heading is also centered. Headings for left aligned tables are also aligned to the left. See also A6.2, page 25.

  Table 1. Relative contents of odd isotopes for heavy elements

| Sample table | Sample table | Sample table | Sample table |

• In many cases borders are not needed around tables. Lines may be used, when necessary, to make the table easier to read. Lines should separate the table heading and column headings from the columns, and the end of the table from the rest of the text.

• Table notes occur immediately following (adjacent to) the table. They are marked with lowercase superscript letters (a, b, c, etc.). For examples, see A6.2, page 25.

• Tables are normally numbered separately from maps, and maps from figures.3

• The table or figure, with its title, should fit on a single page whenever possible.

• Captions for **figures** appear below the object. A period follows the number and the heading. See the caption following figure 1, and A8, page 26, for examples.

---

2 GPS recommends the use of the Leipzig Glossing Rules, which gives the increasingly international linguistic standard for abbreviations: http://www.eva.mpg.de/lingua/resources/glossing-rules.php.

3 In some linguistic theories figures and tables are treated as examples and given that example number.
Appendices include substantiating data that would interrupt the flow of the manuscript. These often include long wordlists, charts, and interview forms. A page break occurs before and following an appendix. The appendices are treated differently than headings and chapter breaks, and so are not numbered. If there is more than one appendix, capital letters distinguish them from each other. For example, “Appendix A: Perturbation of Target Nouns in Tone Frames.”

12 References

GLPS uses the term *references* rather than *bibliography*. References occur following any optional appendices. In collections, the references list may occur at the end of each chapter instead of at the end of the volume. In this section the elements of an entry are described individually and in the order of appearance in the entry (author, date, title, etc).

Current practice is to keep font and punctuation characteristics as simple as possible. All elements of a reference entry, except the title of a book or journal, are given in non-italic, plain type, and without quotation marks. Quotation marks are used only to highlight isolated words or phrases; they do not set off titles of works. Each element in a reference entry ends in a period.

- Reference entries are limited to those actually cited in the text of the manuscript. Additional references are only rarely included in a work, and only if listed separately as *Additional Reading*.

- Some physical facts about a work which are appropriate for library catalog cards or booksellers’ lists—dimensions, type of cover, number of pages in the book, number of illustrations—are not given in a list of references for GLPS.

12.1 Name of authors, editors, translators, and compilers

12.1.1 Authors

The first element of a reference is the author’s name, surname first and set off by a comma, with the given names following in order.

- The author’s given names, as listed in the work, are spelled out—and without citing degrees or titles, e.g., the title, *Ph.D.*, in Charles F. Hockett, Ph.D., is omitted.

  Hockett, Charles F.

- An author’s full name is given, if listed as such. Only if an author prefers to be known by initials only, are they used in lieu of the full name, e.g., Eliot, T. S.

- In the case of **more than one author**, only the name of the first author is given in inverse order. If two authors have the same surname, give each name in full. A comma separates the name of each author from that of the following one.

  Pike, Kenneth L., and Evelyn G. Pike.


- Do not use *et al.* when listing multiple authors in references. The abbreviation may be used in the text citation, but the names of all authors are given in reference entries.
• When two or more publications by the same author or combination of joint authors are referenced in the same list, the list is given first alphabetically, then in normal chronological order.
  
  
  
  
• If a publication issued by an entity bears no personal author’s name on the title page, it is listed by that entity, even if the entity name is repeated later in the same reference entry.
  

12.1.2  **Editors, translators, and compilers**

• The person or people listed on the title page as editors, translators, or compilers are noted in the author category with that function in abbreviated form following their name(s)—eds., trans., comps. These are not given within parentheses. The abbreviation is followed by the date.
  
  
  
  Travis, Donald, and Janet Coombs, comps. 2012.

• Note in section 12.3.3, that editors, translators, or compilers of a larger work within which an article or book is found, e.g., a collection, the abbreviation is given within parentheses.

12.2  **Date of publication**

The second element of a reference entry is the year of publication, set apart from author(s) and title by periods.

• If two or more publications by the same author or combination of authors are listed as having been published in the same year, lower case letters beginning with “a” and “b” are appended to the date, in alphabetical order, to distinguish them for purposes of citation in the text.
  
  McArthur, Harry S. 1966a. El faccionalismo político-religioso...
  
  McArthur, Harry S. 1966b. Orígenes y motivos...

• A manuscript that has not yet been published can be referred to in several ways in lieu of an actual publication date. If the manuscript is scheduled to appear in a particular outlet (an editor has accepted it), the words *forthcoming, to appear, or in press* can substitute for an actual date.
  

• Dates for publications can be given either in European style, with the days preceding the month, or American style, with the name of the month occurring first. The convention should be consistently applied within a work.

• A manuscript for which a specific outlet has not yet been secured can be cited by the date of writing, with the abbreviation for the word “manuscript” (ms.) placed at the end of the citation in lieu of a place of publication and publisher. See also 12.5.
  
A published work that shows no publication date is shown as having no date (n.d.): Smith, John T. n.d. The problem of...

### 12.3 Titles

#### 12.3.1 Book titles

Reference lists for book titles are of various types: Simple monographs, those with multiple editions or volumes, books that are members of a series or collection, and books reviewed in a journal, to name a few. This section shows simple titles, and with subtitles; how editions and volume numbers are shown; and an example of how a foreign title is translated into English.

- **Books** are sentence capitalized and italicized.
  

- **Subtitles** are separated from titles by a colon. The first word of the subtitle is capitalized.
  

- An **edition number** follows the book title, separated by periods, and is written out, not abbreviated.
  

- Some books have **multiple volumes** under the same title. The volume number and the abbreviation for volumes (vols.) is given in lower case, non-italic type following the title and a comma.
  

- A **translation** of may be given in regular type, within brackets following a foreign language title.
  

#### 12.3.2 Series titles

When a book is part of a **series**, the series title and number follow the book title. Series titles are headline capitalized and in regular type. The word number (*No.*) is not used.


- The term **workpapers** is sometimes part of a formal series title, as seen in this example.
  

- A book can be a **part of a series** within a series. See here, and the example for the next bullet point.
  

- Institutional names are sometimes part of a series title, especially in the case of educational institutions. In the following example, 56 is the series issue number. Since the publisher’s name is part of the series title, it is not repeated following the place of publication (see also 12.4).
  
12.3.3 Titles of articles and published papers

Article titles are sentence capitalized and in regular type. Only in the text stream is the title headline capitalized and appears in quotation marks. For a subtitle, a colon separates the title from subtitle. Articles and published papers appear in journals, collections and proceedings.

Articles in a journal

The journal name follows the article title and is headline capitalized and italicized.


- Journal editors are ordinarily not named. The volume and page numbers follow the journal name. They are separated by a colon without an intervening space.
  

- Most journals publish one volume per year with two or more issues. The issue number is not cited unless the journal follows the practice of numbering its pages from “1” in each issue, in which case the number of the issue appears in parentheses between the volume number and the colon.
  

- If volume, number, and issue details must all three be given for a journal article, follow this pattern:
  

Articles in collections and proceedings

An article may be included in a collection of articles assembled by one or more editors; papers read in a professional workshop or conference may, likewise, be published as the proceedings of that event.

In a collection the article title is sentence capitalized and in regular type. It is followed by *In*, the editor’s names (first, then last); the editor’s title (ed.), and the collection title, which is sentence capitalized and in italic type. The title is followed by a comma, the page range for the article, a period, then place of publication and publisher. The word *page(s)* is not used in full or abbreviated form with the page numbers.


- If an author lists three or more articles from the same collection, the collection may be listed as a separate entry.


- If the larger work is listed in the references separately, the individual article entries can be shortened to include only the names of volume editors and page numbers, without other details.


- The book in which an article appears may also be a member of a series, as in the case of Workpapers in Papua New Guinea Languages 21, following:

Papers published in the proceedings of an official event are like articles in a collection. However, the name, place, and date of the conference are given, followed by the page sequence, and place and name of the publisher (which may or may not be the same as the meeting organizers and location).


In the following example the proceedings are given within a series title:


### 12.3.4 Book reviews

Books that are reviewed by others are listed with the reviewer's name followed by *Review of* (without punctuation), the book title, and author(s) or editor(s). Then follow applicable guidelines for citing periodicals. For reviews other than of books, see CMOS 14.214–14.217.


### 12.4 Place of publication and publisher

The last sequence of a reference entry is the city where the work was published and the name of the publisher.

- **Place of publication** is not ordinarily indicated for an article in a journal. However, in the case of a periodical publication of an institution (usually an educational institution—as opposed to a professional society), place of publication and publisher serves to clearly identify the publication.


- The city of publication is given, without reference to country or state unless the city may be confused with another, or the location of the city is not widely known. When the state is given, it is with a three (or 4) letter abbreviation, rather than the two letter postal code, e.g., Ill, rather than IL.

- The printing house is not to be confused with the publisher. The publisher's name is shown as having the copyright.

- The **name of publisher** is the last element of an entry, If the publisher's name appears verbatim elsewhere in the entry as, for example, in the series name, there is no need to repeat it.


- The entry ends with the publisher's name followed by a period.

12.5 Unpublished papers, dissertations/theses, manuscripts

- A paper read but not published gives the author, year, the name of the professional meeting where it was read, the place of the meeting, and the dates of the meeting. The dates may be given either European or American style (see 12.2), as long as that convention is used consistently.
  
  

- A dissertation or thesis gives the author, year, the manuscript title, the degree earned, the name of the institution and location. When the city is part of the university name it is not given separately.
  
  
  

- Unpublished manuscripts are listed with the author, date of writing, the title, and the initials “Ms.” for manuscript.
  
  

12.6 References from a website

- If the author consulted an article online, include a URL. If no author is identified, begin the citation with the article title. Give the title, publisher, and date; then give the date the author accessed the site; follow that with the web site link.
  
  

- A Digital Object Identifier (DOI) is a unique and permanent name assigned to intellectual property such as an article or book. A DOI points to the source, much as do URLs. CMOS recommends use of DOIs as “more reliable resource identifiers,” and suggests that “authors...include DOIs rather than URLs for sources that make them readily available” (2010:657). As seen in the first example, below, the DOI is not hyperlinked (underlined) unless part of the URL, as in example two.
  

- A DOI may be embedded within a URL name (here, at the end of the URL).
  
Appendix A:
SIL Template Guidelines

Title Page Title *(SIL Front Title)*
Subtitle *(SIL Front Subtitle)*
Author *(SIL Front Author)*

SIL International® *(SIL Front Publisher-Year)*
2013

Comments:
• ®, above, uses *SIL Footnote Number* style.
Fair-Use Policy:
Books published in the SIL e-Books (SILEB) series are intended for scholarly research and educational use. You may make copies of these publications for research or instructional purposes free of charge (within fair-use guidelines) and without further permission. Republication or commercial use of SILEB or the documents contained therein is expressly prohibited without the written consent of the copyright holder(s).
A1  Print book headings and chapter titles

In print books, part headings (e.g., abstract, contents) and chapter titles (see below) are styled with \textit{SIL Hdg Ch Ctrd} They are headline capitalized and start a new, odd-numbered page. Chapter titles have the chapter number manually entered immediately above the title using a no-break line space (Shift+Enter).

5  
Sample Title of Chapter Five for a Print Book

First level headings \textit{(SIL Hdg1 Ctrd)} are centered, manually numbered, and sentence capitalized (see below). The two digit number includes chapter and heading numbers, separated by a period and followed by a tab, as illustrated:

5.1 Sample first level heading of chapter five for a print book

Second level and lower headings are aligned flush left and are sentence capitalized. The two digit number includes chapter and heading numbers. Except for the added chapter number, these are identical to the headings in A2.

5.1.1 Sample second level heading of chapter five for a print book

A \textit{collection} is a print book in which each chapter is written by a different author. In this case the author’s name appears beneath the chapter title using \textit{SIL Hdg Ch Author} style. An abstract for the chapter follows the author’s name. The abstract text is styled with \textit{SIL Para 1}.

A2  E-Book and paper headings and chapter titles

For e-Books and papers, all part headings and chapter titles \textit{(SIL Hdg Ch Left)} are headline capitalized; they and level headings are normally flush left. All numbering is manual. A tab is used to space after the number. No punctuation follows either the number or the heading text. E-Books, like print books, may give both the chapter and heading number (see A1, above). See examples, here, and at 4.1.1, page 7.

1  First level heading \textit{(SIL Heading 1)}

1.1  Second level heading \textit{(SIL Heading 2)}

1.1.1 Third level heading \textit{(SIL Heading 3)}

A3  Text: Paragraph styles (and the line spacer)

\textit{SIL Para 1} style is used for the first paragraph to follow a heading. It is not indented. \textit{SIL Para 2} style is for second and succeeding text paragraphs. The first line is indented 0.3”.

\textit{SIL Para Long Quote} style is for quotations longer than four lines; it is in 9 pt type and is set off from both margins. The first line is not indented from the left margin of the paragraph.

Second and succeeding paragraphs within the long quotation use \textit{SIL Para Long Quote 2}, which indents the first line of this paragraph. For more, see 4.2, page 8.
The **SIL Line Spacer** style adds 5 pt spacing between paragraphs. A sample separates this line from this line.

### A4 Character styles

- **SIL Chr Data** (used for IPA and non-italic vernacular data)
- **SIL Chr Italic** (used for emphasis, book and journal titles, etc.)
- **SIL Chr Bold** (use sparingly, for emphasis and table headings)
- **SIL CHR TECHNICAL** (used for special vocabulary; on lower case text, select, then tag this style)
- **SIL Chr Underline** (use sparingly, for emphasis)
- **SIL Chr Vernacular** (used for vernacular data in the text)
- **SIL Chr Vernac Emphatic** (used to emphasize [italicized] vernacular data)
- **SIL Chr Vernac Underline** (used to emphasize [italicized] vernacular data)
- **SIL Footnote Ref** (superscripts footnotes and table notes; used to superscript after apply template)

### A5 Bullet lists, example lists, and interlinear text

**SIL Bullet** and **SIL List Example** styles have the grammar and spelling check feature turned off.

- This is **SIL List Bullet 1** style.
  - This is **SIL List Bullet 2** style.
  - This is **SIL List Bullet 3** style.

Auto numbering keeps your item and example lists ordered. When ready to submit, save one copy, then select the entire text of another copy and freeze the numbering with Ctrl+Shift+F9. This is irreversible. Send both to GPS.

1. **SIL List Item 1** is for numbered or itemized lists, followed by a period and tab, as shown here:
   - This is **SIL List Item 2** style.
   - **This is SIL List Item 3** style.

(2) The **SIL List Examples** style is used for language examples. These are typically numbered within parentheses. A hanging indent keeps the example text aligned, as shown here.

(3) Vernacular word lists can be generated by inserting a manual line break (**Shift+Enter**), instead of a carriage return at the end of the paragraph text and after each word. This is used to style 3a, b.

   a. ȵɪɪŋ
   b. ɗaɑŋpιʊŋ

(4) Style **Interlinear text** with **SIL Table L Text**. See A6.1 to prepare the text and insert into a table.

   - To align an example number with a table, e.g., (5), set up the table; select left column, right click selection; Insert a column to the left, click in the top, left cell, and tag **SIL List Examples**. Select that column; right click; select Table Properties, Column tab, and set Preferred width to .31”.

   - To remove the table border, select the table; at the Design tab, use the Border menu and set No Border. (Here the border is marked for illustration only.) Note that the free translation below the table can be styled as within a cell of the table (A6.2) or separately, as here, with **SIL Para 2**.

|       | phonetic | morpheme | gloss | | | | | |
|-------|----------|----------|-------| | | | | |
| (5)   | m̀ mɪ́ n̊ tigırú wó bɪ́nняmá rI m̀ | m̀ mɪ́ n̊ tigırú wó bɪ́nняmá rI m̀ | m̀ mɪ́ n̊ tigırú wó bɪ́nняmá rI m̀ |
| phonetic | 1s build 1s house | DEF | TRANS | year | DEF | LOC | 'I built my house last year.' |
A6 Tables

A6.1 Table left headings and table left text

The title for tables, charts, and maps, is called a table heading, and appears above the object. Optional column titles within a table or chart are called table headers. These can be styled with **SIL Chr Bold** for emphasis. See examples, tables 1 and 3.

To set up a table, align the text in columns, using tabs. Next, with the entire text selected, at the Insert tab, select Table, then Convert Text to Table, and AutoFit to contents. To left-align the text in each cell, with the entire text highlighted, style with **SIL Table L Text**.

Table cells can be adjusted for height and width. Hover the cursor over table borders, then select the border and drag; alternatively, select the entire table and click on the Layout tab at the right of the ribbon. Then adjust the Cell Size at the center of the ribbon.

Table 1. This is **SIL Table L Heading 1** style

<table>
<thead>
<tr>
<th>Table header</th>
<th>Table header</th>
<th>Table header</th>
<th>Table header</th>
<th>Table header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Text</td>
<td>Table Text</td>
<td>Table Text</td>
<td>Table Text</td>
<td>Table Text</td>
</tr>
</tbody>
</table>

For the **SIL Table L Heading 2** style, with the table already set up (see instructions, above), set the heading; then select the entire table text; at the Layout tab, click Table Properties, Table tab, and Indent from left: at 0.31”.

Table 2. This is **SIL Table L Heading 2** style

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>jɔ́ rɔ́ ŋ</td>
<td>jɔ́ rɔ́ ŋ wʊ́ ná</td>
<td>jɔ́ rɔ́ ŋ káání</td>
<td></td>
</tr>
<tr>
<td></td>
<td>H-H</td>
<td>ŋ ̀ wó jɔ́ rɔ́ ŋ</td>
<td>ɔ́ jɔ́ rɔ́ ŋ</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>hɔ́ gʊ́</td>
<td>hɔ́ gʊ́ wʊ́ ná</td>
<td>hɔ́ gʊ́ káání</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ø</td>
<td>ŋ ̀ wó hɔ́ gʊ́</td>
<td>ɔ́ hɔ́ gʊ́</td>
<td></td>
</tr>
</tbody>
</table>

A6.2 Table center heading and table center text; notes in a table

The **SIL Table Ctr Text** style centers text in table cells. Alternatively, with the full text or table selected, **Ctrl+E** centers both the heading and table on the page, and the text within the cells.

For **table notes**, create an empty cell below the table text and insert the notes into the cell, as follows: Click in the last table cell; select the Layout tab, Insert Below; then Merge Cells. To remove cell border, at the Design tab, Border menu, set No Border; then set Top Border. Use letters or symbols for the table note referent; style with **SIL Footnote Ref**; style the 9 pt table note text with **SIL Footnote Text**.

Table 3. This **SIL Table Ctr Heading** style is also for maps

<table>
<thead>
<tr>
<th>Table header</th>
<th>Table header</th>
<th>Table header</th>
<th>Table header</th>
<th>Table header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table text</td>
<td>Table text</td>
<td>Table text</td>
<td>Table text</td>
<td>Table text</td>
</tr>
</tbody>
</table>

*The table note referents use **SIL Footnote Ref** style.

*The table note text uses **SIL Footnote Text** style.
A6.3  Small and tiny text options for tables

Two paragraph style options allow for a smaller text size for tables, permitting more cells in a table.

<table>
<thead>
<tr>
<th>Table 4. This is <strong>SIL Table Text 9.5 pt</strong></th>
<th>Table 5. This is <strong>SIL Table Text 9 pt</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Small text</td>
<td>Small text</td>
</tr>
</tbody>
</table>

A7  Footnotes

- To insert a footnote use the ribbon: References tab; and Insert Footnote. For table notes see A6.2, page 25.
- Footnote text and footnote numbers may become altered in the process of attaching a template. Use the **SIL Footnote Ref** and **SIL Footnote Text** styles to convert the note numbers and text to the correct form.

A8  Figures and graphics

The **SIL Figure Graphic** style centers the figure or graphic image. The title for figures and graphic images is called a **caption**. **SIL Figure Caption** centers the figure caption below the object.

Figure 1. The **SIL Figure Caption** style centers the caption text.

A9  Appendices and references

**Appendices** are not part of the central text, and so are assigned a capital letter (Appendix A, B, etc.) and are not numbered with the other part headings. Appendix headings are styled with **SIL Hdg Ch Ctrd** (print books) or **SIL Hdg Ch Left** (e-Books and papers). A page break precedes each appendix.

The **references list** is also not part of the central text, and so the heading is not numbered. A page break precedes the part heading. The heading is styled with **SIL Hdg Ch Ctrd** or **SIL Hdg Ch Left**. Individual reference entries are styled with **SIL Reference Entry**. Entries are flush left, with a hanging indent of .25”. See example here and others in section 12, pages 14–19.

### Appendix B: Layout Specifications

#### B1 Basic setup (metadata)

<table>
<thead>
<tr>
<th>Application</th>
<th>MS Word (preferably 2007, 2010 or later)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document division</td>
<td></td>
</tr>
<tr>
<td>Papers</td>
<td>Treat as one document</td>
</tr>
<tr>
<td>Books</td>
<td>If long, complicated, or has landscape pages, separate into chapters</td>
</tr>
<tr>
<td>Page layout</td>
<td>Single page (File&gt;Page Setup&gt;Paper)</td>
</tr>
<tr>
<td>Paper size, layout</td>
<td>8.5” x 11” (File&gt;Page Setup&gt;Paper; or Page Layout&gt;Size)</td>
</tr>
<tr>
<td>Margins</td>
<td>1” all around (File&gt;Page Setup&gt;Margins; or Page Layout&gt;Margins)</td>
</tr>
<tr>
<td>Justification</td>
<td>Unjustified for electronic viewing</td>
</tr>
<tr>
<td>Page numbers</td>
<td>(Insert&gt;Page numbers&gt;Header &amp; Footer); see also B2</td>
</tr>
<tr>
<td>Font: <em>SIL Normal</em></td>
<td>10 pt Charis SIL; 12 pt leading (for all but non-roman script)</td>
</tr>
<tr>
<td>Numbering</td>
<td>Only <em>SIL List Examples</em> and <em>SIL List Item 1</em> are auto numbered</td>
</tr>
<tr>
<td>Security/developer; protect</td>
<td>None/Unrestricted</td>
</tr>
<tr>
<td>Fonts</td>
<td>All embedded or embedded subsets</td>
</tr>
<tr>
<td>Navigation tab</td>
<td>Bookmarks panel and page</td>
</tr>
<tr>
<td>Level-head spaces</td>
<td>Space before and after; same as leading for heading</td>
</tr>
</tbody>
</table>

#### B2 Page numbering and titles in headers and footers

<table>
<thead>
<tr>
<th>Headers</th>
<th>9 pt; regular; right; 11 pt leading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footers</td>
<td>9 pt; regular; left; 11 pt leading</td>
</tr>
<tr>
<td>Front matter</td>
<td>Roman numerals: title and verso pages count but don’t appear; first page number of each new part (contents, preface, acknowledgments, abbreviations, etc.) appears bottom center; top right margin for all others (electronic); alternating top margins for print books.</td>
</tr>
<tr>
<td>Central text page numbering</td>
<td>Number pages with arabic numerals beginning on first page of text. Numbering first appears on page 2 or 3, bottom center; all others top, right.</td>
</tr>
<tr>
<td>e-Books, Print</td>
<td>Arabic numbering begins on first page of text, bottom center; also first page of parts, e.g., chapter 1, Appendix A; the rest all at top, alternating margins.</td>
</tr>
<tr>
<td>Monographs</td>
<td>Page, chapter, author different standards for print books, below: left page—page number flush left, chapter title flush right right page—highest level sect head flush left, page number flush right</td>
</tr>
<tr>
<td>Collections</td>
<td>left page—page number flush left, author name flush right right page—article title flush left, page number flush right</td>
</tr>
<tr>
<td>Dictionaries</td>
<td>left page—first entry on page flush left, page number flush right right page—page number flush left, last entry on page flush right</td>
</tr>
</tbody>
</table>
B3  Front matter and end matter


B3.1  Title page (papers, e-Books)

The text should be nicely centered on the page. The following are guidelines:

*SIL Front Title*
- Papers: 18 pt; bold; centered; 20 pt leading; 114 pt before; 14 pt after
- E-Books: 18 pt; bold; centered; 20 pt leading; 60 pt before; 40 pt after

*SIL Front Subtitle*
- Papers: 16 pt; bold; centered; 18 pt leading; 0 pt before; 14 pt after

*SIL Front Author*
- Papers: 12 pt; regular; centered; 14 pt leading; 0 pt before; 144 pt after
- E-Books: 10 pt; regular; centered; 12 pt leading; 0 pt before; 324 pt after

*SIL Front Publisher-Year*
- Papers: (SIL International®)
- E-Books: 12 pt; bold; centered

*SIL Front Copyright*
- Papers: 10 pt; regular; left; 11 pt leading
- E-Books: 11 pt; regular; left; 12 pt leading

B3.2  Verso page

*SIL E-Books* 10 pt; regular; centered
*xx (series number)* 10 pt; regular; centered
*©2013 SIL International®* 10 pt; regular; centered
*ISBN: xxx-x-xxxxx-xxx-x* 10 pt; regular; centered
*ISSN: xxx-xxxx* 10 pt; regular; centered
*Fair use policy* 9 pt; regular; block: left indent 36 pts; right indent 36 pts
*Production Title* (editor) 10 pt; bold; centered
*Production name* (compositor) 10 pt; regular; centered

B3.3  Contents

No leader or page numbers on contents page. All entries are made into live links.

Contents  See B4; different for e-Books and papers vs. print books
*  Number/tab; 10 pt; regular; left; headline capitalized
*  *SIL TOC Bk 1*  Number/tab; 10 pt; regular; indent to first letter of level 1
  *SIL TOC Bk 2*  Number/tab; 10 pt; regular; indent to first letter of level 2
  *SIL TOC Bk 3*  
*Appendices*  Regular; left; 10 pt; headline capitalized
*References*  Regular; left; 10 pt; headline capitalized; hanging indent .25″; 6 pt after
B4  Headings

**SIL Hdg Ch Left** (e-bks, papers)
- After p. break; 14 pt; bold; left; 16 pt leading; 16 pt before, 16 after

**SIL Hdg Ch Ctrd** (books)
- Contents title
- Abstract title
- Abbreviations title
- Appendices titles
- Reference title
- Chapter titles

**SIL Hdg Ch Authors**
- After p. break; 14 pt; bold; centered; 16 pt leading; 16 pt before, after

**SIL Hdg1 Ctrd**
- Books (1.1+tab)

**SIL Heading 2**
- Papers (1.1+tab)
- Books (1.1.1+tab)

**SIL Heading 3** (1.1.1+tab)
- No chapter number with heading number; manually number all hdgs

**SIL Heading 4**
- Ditto, except .3″ left indent

**SIL Heading 5**
- Ditto, except .5″ left indent

**B5  Paragraphs, bullets, and list examples**

**SIL Para 1**
- 10 pt; regular; left; 12 pt leading; 0 pt before; 0 pt after

**SIL Para 2**
- Ditto, except .3″ left first line indent

**SIL Para Long Quote**
- 9 pt; regular; .5″ left indent; .5″ right indent; 11 pt leading; 6 pt before; 6 pt after

**SIL Para Long Quote 2**
- 9 pt; regular; .5″ left indent; .5″ right indent; 11 pt leading; 0 pt before; 6 pt after; .25″ first line indent

**SIL Line Spacer**
- 5 pt; regular; left; single line space

**SIL List Bullet 1**
- 10 pt; regular; no indent; .3″ hanging; 12 pt leading; 3 pt before; 3 pt after; no spelling, grammar check

**SIL List Bullet 2**
- Ditto, except .3″ left indent; .2″ hanging

**SIL List Bullet 3**
- Ditto, except .5″ left indent; .2″ hanging

**SIL List Examples** (and)
- 10 pt; regular; left; .3″ hanging; 12 pt leading; 3

**SIL List Item 1**
- (1)+tab; auto numbered
- List item
- List examples

**SIL List Item 2**
- Ditto, except .3″ indent; .2″ hanging indent; manually numbered

**SIL List Item 3**
- Ditto, except .5″ indent; .2″ hanging indent; manually numbered

**SIL Reference Entry**
- 10 pt; left; .25″ hanging; 12 pt leading; 0 pt before; 6 pt after;
- alphabetical by author; for multiple entries by same author, enter name, (not line); chronological order, with earliest date first
B6  Figures, tables, and maps

**SIL Figure Graphic**
Regular; centered; single line space; 10 pt before; 0 pt after

**SIL Figure Caption**—below figure/graphic image
10 pt regular; centered; 12 pt leading; 6 pt before, 10 pt after; no spelling, grammar check; keep lines together

**SIL Table Ctr Heading**—above tables and maps
10 pt; regular; centered; 12 pt leading; 10 pt before; 7 pt after; keep with next

**SIL Table Ctr Text**
10 pt; regular; centered; 12 pt leading; 1 pt before; 1 pt after; keep with next

**SIL Table L Heading 1**
10 pt; regular; .3″ indent; 12 pt leading; 10 pt before; 7 pt after; keep with next

**SIL Table L Text**
10 pt; regular; left; 12 pt leading; 3 pt before; 3 pt after; keep lines together; keep with next

**SIL Table Text 9 pt**
9 pt; regular; left; 11 pt leading; 2 pt before; 2 pt after; no spelling, grammar check

**SIL Table Text 9.5 pt**
9.5 pt; regular; left; 11 pt leading; 2 pt before; 2 pt after; no spelling, grammar check

B7  Footnotes, table notes, and reference entries

**Footnote line**
Regular; left; 2 inches long

**Line continued**
Regular; margin to margin

**SIL Footnote Ref** (referent for footnotes, table notes)
(Character style) regular; superscript (follows text punctuation)

**SIL Footnote text**
Footnote appears at bottom of page; table note is at base of table

9 pt; regular; left; 11 pt leading (adjacent to note referent)

B8  Character styles

In addition to the **SIL Footnote Ref**, the following are character style options:

**SIL Chr Bold**
Bold

**SIL Chr Data**
Regular; no spelling, grammar check

**SIL Chr Italic**
Italic

**SIL Chr Technical**
Small caps

**SIL Chr Underline**
Underline

**SIL Chr Vernacular**
Italic; no spelling, grammar check

**SIL Chr Vernac Emphatic**
Bold italic; no spelling, grammar check

**SIL Chr Vernac Underline**
Italic underline; no spelling, grammar check

**SIL Chr Raised 3 pt**
Raises vernacular character 3 pts

**SIL Footnote Ref**
Superscripts footnote or table note referent

**Hyperlink**
Links to target element. Font: Underline; Font color: Blue

When the Word manuscript has been finalized make a PDF. Then add bookmarks and the metadata.
Appendix C: Editing Tips and Checks

C1 Front matter

- Check that the author’s name is correct; full name, if known (no nicknames).
- Check ISBN, LOC, ISSN, and series numbers.
- Check that cover design has correct acknowledgment.
- Make final check of headers: titles and page numbers, as compared with contents.

C2 Text

C2.1 Overview

- Check that section numbers and titles match the contents. (Also that subheadings are consistent.)
- In an abstract, an introduction, and an introductory sentence of a section, the list of topics should be in the same order as they are presented in the following discussion or subsections.
- Watch for wrong use of discourse links.
- Is the logic of the relationship of one proposition to another correct?
- Check for collocational clashes; non sequiturs, clichés.
- Avoid excessive redundancy: repetition of a word, phrase, or syntactic device.
- Avoid mixed metaphors.
- Correct errors in factual statements.

C2.2 Punctuation, symbols, and emphasis

- Check punctuation with double quotation marks: the closing quotation mark should normally follow any other adjacent punctuation mark. Single quotation marks in a gloss precede punctuation.
- Use a period at the end of sentence preceding an example, rather than a colon, whenever possible.
- Avoid hyphenating prefixes such as non and co.
- Be consistent in use of commas:
  - After e.g. and i.e.
  - In a series before and or or.
- In a compound sentence with a change of subject, a comma occurs before the conjunction.
- Do not use an ampersand (&); write out and—unless it is part of a proper name or trademark.
- Make sure special symbols are clear; e.g., accent too close over vowel, null symbol is correct.
- Check that italics, bold, small caps, and underlining are used consistently, and not over used.

C2.3 Grammar

- Check person and number agreement between subject and verb.
- This and that often need to have a noun added following them to avoid ambiguity.
- Use etc. sparingly. It is not used after for example (e.g.); rather, use and before last item of a series.
- Check for inaccurate use of a word, e.g., a similar sounding word used in place of the correct one.
- Contractions should be written out, e.g., do not, for don’t. These often occur in free translations.
• Avoid overuse of *below, above, and following*.

### C2.4 Numbers, numerals, spelling, and dates

- Numbered or lettered items in text have both an opening and closing parenthesis, i.e., (1) or (a) but not 1) or a); numbers are preferred.
- It is better not to begin a sentence with an example number, e.g., “(91) presents a…”). You can insert the word *Example* before the example number.
- Note that bulleted paragraphs are often useful and keep a paragraph from being too heavy. However, do not list too many bulleted items together.
- Page or date sequences are written out fully and require an en dash, not a hyphen, e.g., 95–96, not 95–6.
- Check for mistakes in dates, personal names, titles, and place names.

### C3 Vernacular and interlinear text

- Check that International Phonetic Alphabet (IPA) symbols are used consistently and correctly.
- Vernacular capitalization and sentence punctuation decisions are left to the author. However, these are what is typical of vernacular text:
  - Normally only proper names are capitalized and punctuation is not used.
  - Vernacular in the text is in italic type; in tables it is in regular type.
- Avoid beginning a sentence with vernacular use (since these would normally be lower case).
- Gloss and vernacular
  - Make sure glosses are lined up with vernacular
  - there should be the same number of hyphens in the gloss as there are in the vernacular.
  - Where there is a two word gloss for one word vernacular, a period is used to combine the two words, and vice versa.
- Free translation is marked with single quotation marks.

### C4 Tables and figures

- Make sure table headers are consistent (caps and bolding) throughout manuscript. Table headings are not followed by punctuation.
- Check figure titles for consistency throughout manuscript. Figure captions end with a period.

### C5 References

- See references (section 12, pages 14–19) for correct order and form of reference items.
- Look for any missing data in the linguistics library or online at the SIL Bibliography, *WorldCat*, or *Library of Congress* sites; otherwise, ask the author to provide what is missing.
Appendix D: Compositing and Editing Checklist

Title _____________________________________________________________
Author(s) ____________________________________________________________________________________

Compositing and copy editing

General
0 Headers are given correctly. See sections 2, page 6; and B2, page 27.
0 The SIL template is attached. Attach if necessary; tag with right styles. Check for centering, size, color.
0 Page Setup is correct: Size (Letter), orientation (Portrait), margins (top, bottom, sides: 1”).
0 All styles are applied consistently for paragraphs, lists, block quotes, figures, tables, character styles.
0 Only SIL Unicode fonts are used, and are consistent—Charis SIL, Doulos SIL, Galatia SIL, Ezra SIL.
0 No break space keeps a numbered item and the text in the text together, e.g., “as follows: 1. First,...”
0 Extra spaces at sentence ends and extra paragraph markers have been eliminated.
0 When the manuscript is finalized, the compositor’s last step will be to autogenerate the table of contents.

Figures, tables, maps, charts
0 Table or map headings (above) and figure captions (below), are correct.
0 Figures, tables, and maps are oriented correctly—not hidden by text, or broken across pages—if avoidable.
0 Places referred to are indicated on the appropriate map.
0 Numbering sequences for figures, tables, and maps (sections and examples—no 1 or 1.1 without a 2).
0 Lengthy example text is placed in a table.
0 Columns are aligned; formatting is consistent throughout the manuscript.
0 Notes in tables and figures are placed immediately following the table or figure—not at the foot of the page.
0 Tables use no more than top and bottom border lines unless side borders are helpful for understanding.

Footnotes
0 Consecutive throughout. (Note: track changes affect footnote numbering until changes are accepted.)
0 Footnotes: Referents are superscript (in text and with note); referent is on the same page as its note.

Content and copy editing

Front matter and metadata
0 Title, subtitle, author (no nicknames), publisher, and year are correct. No title or heading is in all caps.
0 Author sent abstract and metadata: Language (ISO), dialect, country, fonts used, 5–8 key words.
0 Author sent permissions for use of all graphics, photos, names, etc.

Text
0 Read contents section and scanned paper for overview of meaning. Parallel constructions? Consistent? Concise?
0 Section headings and text content are consistent and parallel throughout.
0 Vocabulary is inoffensive; mention of religious affiliation and persuasion is as minimal as possible.
0 Neither individuals nor cultures appear in an unfavorable light.
0 If reference to a person or any information requires informed (recorded) consent, author sent that permission.
0 Parentheses, braces, brackets, and quotation marks have both opening and closing marks.
0 Make sure all quotes and apostrophes are “smart.”
0 Em dash and en dash—no space before or after; line breaks after em dash; en dash used for number sequences.
0 End-of-line hyphenation is correct; last line on each page is followed by proper text on first line of next page.
0 Contractions are written out, e.g., do not for don’t.
0 Read through for spelling, grammar, capitalization, and consistent punctuation. (Use spell checker.)
0 Writing style is consistent throughout, e.g., British English spelling, hyphenation, use of commas.
0 Abbreviations used in the gloss line match the abbreviations list.
0 Items referred to are shown in the appropriate figure, table, or map.
0 Carefully check corrected text against original manuscript.
0 Cross references made in the text must correspond with intended destination.

End matter
0 Optional appendices precede references, and are titled using A, B, C, etc., rather than numbers.
0 Each text citation has a matching reference entry, and each reference entry has a corresponding citation.

Date and signature ____________________________________________________________